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1. Overview 
 

The Natus Platform Migration Utility is an application which migrates patient, exam, and report data 
from legacy source systems such as Nicolet NicVue and Study Room, Grass Twin, and Schwarzer DMS 
(Data management System) to the Natus Database application, used with NeuroWorks. 

This document describes the process to use the application and provides preparation and follow-up tips 
when executing the migration process. 

 

Before proceeding with Migration it is important that the limitations in Section 10.2 
are understood and communicated to the customer.  

 

NeuroWorks and SleepWorks share the same database and framework. Therefore, all 
further references in this document for NeuroWorks also apply to SleepWorks. 
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2. Pre-installation Requirements 

2.1 Prerequisites 
 NeuroWorks 8.4 GMA1 
 Natus Platform Migration Utility “NatusPlatformMigration_QA_8.4.0.516_1606271604.exe” 
 Nicolet and Grass platforms: Study data not located on removable media must be accessible 

online for the migration utility 

 Schwarzer platform: All studies must be archived before migration. Studies which are not 
archived will be migrated but cannot be reviewed from NeuroWorks/SleepWorks database. 
 

2.2 Minimal specifications of databases for legacy platforms and 
NeuroWorks 

 Nicolet – NicVue Nicolet - 
StudyRoom 

Grass – TWin Schwarzer –DMS 

Database version NicVue ver 3.0 

(SQL) 

StudyRoom 
5.93.0.424 (SQL)  

TWin 5.2.0 
(SQL) 

DMS 7.1.210 
(SQL) 

 

 
Note: Systems running older versions of databases must be upgraded prior to migration. 

2.3 Minimal specifications for the Natus NeuroWorks systems used 
for review with legacy readers 

 NeuroWorks 8.4  
GMA1 

Nicolet 
“NicOne” 
review 
application 

Grass “Twin” 
review 
application 

Schwarzer 
“Coherence” 
review application 

Operating 
System 

Win7 Pro or Ultimate 
(SP1) 32/64-bit   

Windows 7, 
64-bit 

Windows 7 Pro or 
Ultimate, 32-bit or 
64-bit 

Windows 7 Pro or 
Ultimate, 32-bit or 
64-bit 

SQL server SQL Server 2008 R2 
(RTM or SP1)  

 

(not 
applicable- 
review only)  

(not applicable- 
review only) 

(not applicable- 
review only) 

MS Office Office/Word 2007  

Office/Word 2010 32-bit  

Office/Word 2013 32-bit 

Office/Word 2016  

Office/Word 
2007 or higher 

Office/Word 2007 
or higher 

Office/Word 2007, 
2010, 2013 

CPU Core i5 or better  

 

Intel-i7 or 
better 

Core2 Duo or 
better 

Core2 Duo or better 

RAM 4GB or higher 4GB or higher 4GB or higher 4GB or higher 



Natus® Platform Migration User Guide 

5 

 NeuroWorks 8.4  
GMA1 

Nicolet 
“NicOne” 
review 
application 

Grass “Twin” 
review 
application 

Schwarzer 
“Coherence” 
review application 

Version NeuroWorks 8.1 GMA5 NicoletOne 
min. version 
v5.9.0- W7, 
latest release 
recommended: 
v5.94.1 

TWin 5.2.0 Coherence 
7.1.3.2032  

(= Coh 7.1 SP1) 

 

Refer to the NeuroWorks User Manual or Release Notes for more details on requirements for installing 
NeuroWorks 8.4 GMA1.  

3. The Migration Scenario 
 

Although the migration utility allows for conversion to an existing NeuroWorks database, only 
migration to an empty database has been validated. In a next step, the concept of Virtual databases 
in NeuroWorks allow showing the migrated database and a native NeuroWorks database as if they 
were a single database. 

This process can be carried out from NeuroWorks system having access to SQL servers and data 
servers from the legacy and NeuroWorks platforms. 

 
Note: Prior to migration, make sure to upgrade the site to NeuroWorks 8.4. 

Migration workflow: 

1. Create a new database for migration of the legacy database and add its Storage resource to the 
Virtual database  refer to section 4.3 

2. If required, add custom fields to the new database  refer to section 4.4 

3. Run the migration utility to migrate the legacy database to the new database  refer to sections 
4.5 and 5 

4. Train the user on the features and limitations related to reviewing legacy studies in NeuroWorks 

The following diagram shows a site with a NeuroWorks database for native NeuroWorks studies and 
a migrated database named Migration_db. Both databases are presented to the user as a single 
database. 
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Figure 1: Database Diagram 
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4. Preparation for Migration 

4.1 Back Up Databases 
A local backup of the primary source database and the clean NeuroWorks database should be stored 
in a safe location on a disk.  While the source database is not modified by the process, the backup of 
the clean NeuroWorks database should be retained until the process is completed and approved.  If 
there are issues with migration, this backup of the NeuroWorks database will need to be restored to 
allow the process to be run again. 

4.2 Ensure access to SQL servers hosting source and destination 
databases 

Make sure that the machine and User account running the Migration Utility have access to the 
server(s) hosting the Legacy and NeuroWorks/SleepWorks Databases.    

4.3 Ensure Exam Repositories are Online 
All machines and network locations which house study and report data must be online and accessible 
to the user account and machine on which the utility is run (except for removable archive media). If 
not, the utility will run slower and will warn the user as it is looking for files that are not accessible. 

4.4 Create a new NeuroWorks database 
 

1. Create a new NeuroWorks database using the MigrateDB.exe utility. 

 

Figure 2: NeuroWorks Database Creation using MigrateDB.exe Uti l ity 

2. The default name of the new database (“Neuroworks”) must be changed to any other name by 
selecting the Options… button. 
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Figure 3: Updating the New Database Name 

 

3. In Natus Database, go to Tools > Options > Storage tab. 

4. Under Virtual Database Storage Resources, click Add.  
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Figure 4: Storage Tab (Detail) 

5. Import the DSN file for the newly-created database. 

 

Figure 5: Importing DSN File – Storage Resource (Detail) 

6. The Natus Database displays the following message indicating that the database will be updated 
to the latest version. 

 

Figure 6: Database Upgrade Message 

The database is upgraded. 

 

Figure 7: Database Upgrade Progress 
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7. The new database displays under Virtual Database Storage Resources. 

 

Figure 8: Storage Tab with New Virtual Database Storage Resource 
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4.5 Create/Initialize Custom Fields in NeuroWorks 
You may need to create custom fields in the new NeuroWorks database: 

1. Because NeuroWorks does not have the appropriate field to migrate to. 

2. Because in some cases the corresponding field in NeuroWorks is not available for migration.   

Custom fields need to be created prior to running the migration utility. Custom fields from a source 
database cannot be mapped to standard fields in the Natus Database.  

Your NeuroWorks installation should be configured to synchronize settings with any existing 
NeuroWorks systems at the site. 

The following legacy fields require migration to custom field in NeuroWorks: 

Twin DMS 

 

Field name in Twin Field type in 
NW 

Field name in DMS Field type in NW 

Archived Text  Patient remark Text 

Disc Label Text  File name Text 

End Date Time DateTime  Archive label Text 

Interp Date DateTime  Data drive Strings 

Message Code Text  Location Text 

Order Number Text  Medication 1 to 4 Text 

Procedure Code Text  Medication 5 to 8 Text 

Scored Text  Medication 9 to 12 Text 

Scoring Tech Text  Medication 13 to 16 Text 

Test Site Text  Clinical info Strings 

Complaint Text  Comment Strings 

Diagnosis Text  Diagnosis 1 to 4 Text 

Electrodes Text  Diagnosis 5 to 8 Text 

Medication Text  Recording Remark Text 

Refer Last, First 
Name 

Text  Case Nr. Text 

Refer Last Name Text    

Comments Strings    

ESS Number    

Neck Size Number    
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NicVue StudyRoom 

 

Field name in 
NicVue 

Field type in 
NW 

Field name in 
StudyRoom 

Field type in NW 

Exam Comments Strings Patient Site Text 

CPT Code Text Maiden Name Text 

Exam History Strings Patient Notes Strings 

ICD-9 Text Medication Text 

Medication field 1 Text Test Notes Strings 

Medication field 2 Text Patient State Text 

Order ID Text Abbreviated Study 
Type 

Text 

Exam type Text Secretary Text 

Patient Comments Strings Recording Site Text 

Insurance Company Text Recording "Type Text 

Insurance Number Text Diagnosis Text 

Primary Physician Text 
 
 
 

Additional considerations when creating custom fields include: 

4.5.1 List Types 
Avoid using predefined lists for text fields; use plain text entry types instead.  The utility will only 
allow mapping of fields to “free text” types.  If source data is in a selection list, the selected value 
or values will be migrated as text. 

4.5.2 Custom Radio Buttons 
Avoid using “custom radio buttons” where labels are overridden. If custom radio buttons are 
required, ensure the first value is the “false” value and the second is the “true” value. 
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4.6 Gather Additional Information 
Specific platforms may require additional steps prior to migration.  As such, additional information 
may need to be gathered or managed prior to migration of the database.  Currently TWin and Study 
Room both have additional steps required for migration to occur smoothly. 

4.6.1 Grass TWin 
 Unit of Measure for Patient Height and Weight – Since TWin has no standard unit of 

measure for Patient Height and Weight in the database, the unit of measure for each of these 
values must be determined prior to migration of the data.  Height can be in Centimeters, 
Meters or Inches.  Weight can be in Grams, KG or Pounds. 

4.6.2 Nicolet Study Room 
 Report Format – Microsoft Word Reports – Study Room has the option to turn off HTML 

reports and use Microsoft Word format for reports.  If the Study Room installation being 
migrated uses Microsoft Word format for reports, there is an additional step to convert these 
to a format that can be launched from within the Natus Database. 

 Unit of Measure for Patient Height and Weight – Since Study Room has no standard unit 
of measure for Patient Height and Weight in the database, the unit of measure for each of 
these values must be determined prior to migration of the data.  Height can be in 
Centimeters, Meters or Inches.  Weight can be in Grams, KG or Pounds. 

 

4.6.3 Schwarzer DMS 
 

For DMS, customer must make sure that all studies are archived prior to migration. 
This is required in order for the NeuroWorks database to launch the Coherence viewer 
with a valid data path and filename. 

 

The LTM slideshow option in DMS allows for study files of a same recording being 
archived on more than one disk, while NeuroWorks requires one archive media for all 
files belonging to the same study. In this case the migration utility will split the study in 
several studies containing the same clinical information and report but with a link to a 
single archive disk. The original study showing “&Slide” archive label cannot be reviewed 
and may be deleted from the migrated database in NeuroWorks by sorting the study list 
by archive media and use “Permanently delete study”. 
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5. Using the Utility 

5.1 Verify Backups 
Upon launching the utility, the following welcome screen displays: 

 

Figure 9: Preparation for Migration Screen 

The application asks for verification that all databases have been backed up.  Migration cannot 
proceed until the box verifying that you have completed the back-up process has been selected. 
Once the necessary backups have been created, select the checkbox and click Next to continue. 

Database back-ups should be done using SQL Server tools.  These tools are available with SQL 
Server or free from Microsoft, and are not included with this utility. 

5.1.1 Source System Database 
While the source system databases are not modified during the migration process, it is a 
recommended practice to create a backup of source system databases as a “point in time” reference 
for support if needed. 

5.1.2 NeuroWorks System Database 
Ensure that a backup of the clean database is made. If there are issues during migration, the 
procedure for recovery is to restore the clean backup and then re-run the migration. 

5.2 Select Source System 

  

Figure 1: Source System Selection Screen (Detail) 
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Enter connection information for the source system, and then click Next to continue. 

1. Select the source system.  The source system selected will determine the adapter that is used 
to extract data.  The source platform should match the software and version of the source 
database. 

 

Note: You do not need to have the software installed for the source system; you just 
need to be able to access the database with “read” permissions on the primary 
database. 

2. Enter database connection parameters (Server Name, User name and Password). 

 

Note: If the logged-in user account has “read” permissions on the source system 
database, leave the User name and Password fields blank to use Windows integrated 
security. 

3. For TWin or Study Room migrations, select Unit of Measure used in the source implementation 
for Height and Weight.  The height and weight units specified here will be used to convert height 
and weight values to NeuroWorks standard Grams and Centimeters during the migration process. 

 

Note: This is not necessary for NicVue migrations, which have standardized height and 
weight stored in the database. 

4. For Study Room installations that use Microsoft Word, launch the Report Conversion utility and 
run it on those reports. 

a. The report conversion utility must be run on a machine with Microsoft Word installed. 
Ensure file system write access permissions are available on the Study Room reports 
folder. 

b. Enter the database connection information for the Study Room database. 

c. Click Convert Reports.  The reports will be converted in place to *.doc format and 
information will be shown in the log window of the Report Conversion utility. 

 

Figure 2: Report Conversion Dialog 

5. For Schwarzer DMS migrations, the migration utility needs to detect important settings from the 
site configuration. Therefore it is required to browse to a DMS database configuration file “nke.ini” 
containing this information when selecting DMS source database in the migration utility. Make 
sure to use an nke.ini having the following parameters set up correctly: 

1. Path to main database folder on the Server  This path will be used as a target for 
extraction of reports from the DMS database:  
[MAIN_DATABASE_DIRECTORY]\Reports\YYYY (YYYY = year of recording of the study). 
This extraction will take place during the “Preview” phase in the Migration process (see 5.5).  

2. If existing, path to Online Archives: Refer to parameter “LABEL_ARCHIVE_ON_SERVER=” 
in the nke.ini file or verify the settings in the configuration tool. 
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5.3 Select Destination System (NeuroWorks) 

 

Figure 3: Destination System Selection Screen (Detail) 

Enter connection information for the NeuroWorks destination system.. 

1. Select the destination system version. This will be a version of NeuroWorks supported by the 
tool. 

2. Enter database connection parameters (Server Name, User name, and Password). 

 

Note: If the logged-in user account has administrator permissions on the NeuroWorks 
database, leave the User name and Password fields blank to use Windows integrated 
security. 

3. IMPORTANT notes about using the “Offline reports” field: 

a. For migration from Nicolet StudyRoom, which does not have a concept of offline reports, 
the path to the online documents folder must be added in the field “Offline reports”. This 
path is used for studies archived on removable media! Click the Test button to validate 
the path.  

b. For migration from Schwarzer DMS also, it is recommended to define the path to the 
“Reports” folder located in the DMS application folder on the server (= 
[Main_database_directory]\Reports). During the “Migration” phase (refer to 5.6) the 
migration utility will create an INI file with the path to the report file for each report. 
NeuroWorks opens the report stored in this location available from the report INI file. 
Note that for large databases this process can take several hours.  

 
Click Next to continue.  
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5.3.1 Settings Database Connection 
If the target NeuroWorks database is not a primary database and thus does not contain the custom fields 
schema, the user will be prompted for credentials for a primary NeuroWorks database. By default, this is 
the database named “NeuroWorks” on the local SQL Server instance. The location of the primary 
database can be changed by editing the key “SecondaryDbServerForCustomFields” in the 
PlatformMigration.WindowsClient.exe.config file. 

 

Figure 4: Credentials Prompt for Primary NeuroWorks Database 

5.4 Custom Field Mapping 

 

Figure 5: Custom Field Mapping Screen (Detail) 

With this utility, there is the option to map custom fields within the patient record to the clean 
NeuroWorks database. 

5.4.1 Mapping Custom Fields 
To map custom fields, select the Natus Database custom field from the selection list in the Maps To 
column. These selections will be the destination of the fields loaded in the Source Field column via 
the utility.  Only custom fields where the source system datatype maps to the target system datatype 
can be mapped. 
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Note: Not all source systems support custom fields.  For these systems, the Map Custom 
Fields screen shown above will not appear. 

5.4.2 Exporting the Custom Field Mapping CSV Report 
Clicking the Export CSV button will generate a comma-separated values (CSV) file that will open in 
Excel.  This file is a report listing all custom fields in the source system and their current mapping in 
the destination system.  This report can be used as a historical record of the mapping settings used at 
the time of migration or as a tool to communicate and plan mapping of custom fields. 

5.5 Migration Preview 

 

Figure 6: Migration Preview Screen (Detail) 

The Migration Preview screen performs the following actions: 

 Retrieves all patient records that have non-deleted studies 

 Retrieves each study and report record for selected patients 

o Checks for the presence of study and report data files for “online” studies 

 Retrieves custom field values from patient records per the mapping settings performed in the 
prior step 

Errors and warnings will be displayed in the “Log Report” section of the window, which is located on 
the right-hand side of the utility screen.  At the end of the Migration Preview, statistics and record 
counts are displayed.  Review these and only continue if they are as expected. 

5.5.1 Migration Preview CSV Export 
The Export CSV button will generate a report containing statistics as well as the warning and error 
entries in the Log Report.  This can be used to clean up records in the database and investigate file 
system access issues. This report can be saved as a record of the migration process. 
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5.6 Data Migration 

 

Figure 7: Data Migration Screen (Detail) 

The Data Migration step displays a progress view with details of the migration process.  Errors and 
warnings will be displayed in the Log Report section of the window. 

5.6.1 Re-running Migration 
If there are a significant number of errors or any critical errors displayed in the Log Report section, 
the migration process can be re-run by performing the following steps: 

1. Restore the backup of the clean NeuroWorks database over top of the destination database to 
reset all data 

2. Re-run the migration process after fixing the issues that caused the errors. 

5.7 Post Migration Validation 
During the migration process, a separate set of validation checks are run against files and data 
records in the NeuroWorks database. These results can be viewed on the Post Migration 
Validation view and can be exported using the Export CSV button. 

6. Install Legacy review applications 
 

Legacy review applications must be installed using the respective installers. 
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For Grass TWin and Nicolet NicOne applications, using exclusively hardware USB dongles, the existing 
USB dongles can be reused on the NeuroWorks/SleepWorks review stationsrequiring access to Legacy 
study data. 

For Schwarzer/Deltamed Coherence, using software licenses, an activation code may be requested for 
each NeuroWorks/SleepWorks review unit requiring access to Legacy study data. The number of free 
Coherence review licenses shall not exceed the number of existing Coherence review units. Additional 
review licenses must be purchased separately. 

 

7. After Migration 
After migration is complete, the user can perform the following steps: 

1. Perform appropriate spot-checks as necessary to confirm that migration completed successfully. 

2. Merge the NeuroWorks database into the network per Natus Database standard operations/tools. 

3. Save exported CSV reports to a safe location for long-term storage and reference. 

8. Notes 

8.1 General Notes 

8.1.1 Height and Weight 
When Height and Weight are migrated to NeuroWorks, they are converted to centimeters and 
grams.  The values stored in NeuroWorks are whole numbers (no fractions or decimal places), so 
if values are converted from the source system they may be slightly rounded. 

8.1.2 Temp Data Lock File Warning 
In order to complete the migration, the utility temporarily stores source system data into an 
intermediate database before sending it into NeuroWorks. This allows the user to review the initial 
migration and begin again without having to load the clean NeuroWorks database if possible. 

If the utility is run multiple times, the intermediate database may lock and the following warning 
will fire prior to launching the utility: 

 

Figure 8: Troubleshooting: Temp Data Lock Warning Dialog 
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In order to remove the lock follow the path listed in the warning pop-up, locate the file called 
“mongod.lock”, right-click the option, and then delete it. The warning will disappear from the utility. 

8.2 NicVue Migration Notes 

8.2.1 City and State Fields 
In NicVue, there is only one field for city and state.  This is mapped to the “City” field in 
NeuroWorks. 

In Study Room, there is only one field for all address data.  This is mapped to the “Address 1” 
field in NeuroWorks. 

8.2.2 Compatibility with Persyst 

 

If Persyst 11 is installed on NeuroWorks units used for reviewing Nicolet legacy 
studies, it is required to upgrade to Persyst 12 or higher.  

8.3 TWin Migration Notes 

8.3.1 Removing TWin Portal Study Placeholder Entries 
For those sites migrating from TWin 5.2.0 and also using the TWin Portal HIS/HL7 application, 
HL7 study placeholders are imported from Twin into the NeuroWorks database.  Post-migration, it 
will be desirable to remove these placeholders from the NeuroWorks database. 

The placeholder studies can be identified in the NeuroWorks database having Duration values of 
“0:00:00” and Legacy Paths as “MTYP=PATH;MLID=;MSID={Created by HL7 TwinPortal}”.  
These entries in the NeuroWorks database can be easily removed by following instructions. 

3. Open the Natus Database. 

4. Sort the database by clicking the Legacy Path column header.  Notice all studies with a 
Legacy Path of “MTYP=PATH;MLID=;MSID={Created by HL7 TwinPortal}” move to the 
top of the database. 

5. Use <Ctrl>+Click or <Shift>+Click to select the studies to be removed. 

6. Administration > Permanently Delete 

7. In the Enter Password window, type the password and then click OK. 

8. In the Warning!!!! Window, click “Yes to All” to delete the selected HL7 placeholder 
studies.   

8.4 Study Room Migration Notes 

8.4.1 Study Room Upgrade to SQL Server 
The Study Room database must be upgraded to the current SQL Server version of the 
application prior to migration.  This can be done using the NicoletOne utility Database Tool.   
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Note: Administrator permissions in SQL Server (server sysadmin, owner or 
master) are required to complete this process. 

1. Open the Database Tool (Start > NicoletOne Utilities > Database Tools) 

2. Create a blank TAUG database 

a. In the Common section, enter the following: 

i. Server = SQL Server name 

ii. Database Type = TAUG 

b. In the Action section, set the Action to Create 

c. In the Create section, enter the database name and click “Create” 

3. Import the Access database 

a. In the Import section, do the following: 

i. Select the .mdb file of the Access database being upgraded in the From Access 
file picker. 

ii. Select the new blank database that was created in the Destination Database 
drop-down. 

iii. Click Import. 
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9. NeuroWorks Settings 
There are a number of settings used to govern how the Natus Database interacts with migrated (legacy) 
studies. In the Natus Database, click Tools > Legacy Product Settings. The following dialog appears: 

 

Figure 9: Legacy Product Sett ings Dialog 

Settings:  

Setting Description 

Viewer path This read-only field displays the path to the legacy viewer’s executable file used to 
launch a review session for studies of this product type. The path displayed will 
either be automatically detected or can be manually entered using the “…” browse 
button when the 'AutoDetect viewer path' option is unchecked (the browse button is 
disabled when 'AutoDetect viewer path' is checked). 

AutoDetect viewer 
path 

Check this to have Natus Database attempt to automatically determine the location 
of the viewer executable. When this option is selected, the browse '’..' button is 
disabled. 

Establish 
connection as 
required 

This option enables use of the Credentials Cache technology to establish a 
connection to the share indicated by the resolved study file path and/or alternate 
report location. If this option is not enabled, the logged-on user must have access 
to these shares. The STORAGE_RESOURCE touch-point must be enabled to 
make use of the Credentials Cache for legacy integration. Note that although 
'AutoDetect viewer path' appears as a separate setting for each product type, in 
reality, once a network connection is established for one product, it is available to 
all products. 

Additional Options Click on the’'>' button to open the 'Additional Options' dialog for each product as 
discussed below. 
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9.1 Additional Options 

An additional UI component is used to configure 

auto-placement and report extensions. Click . 
The following dialog appears: 

 

Use this dialog to enable dual-monitor auto-
placement and to configure report extensions. Note 
that a list of known report extensions is enforced by 
this dialog and must be among the following list: 
doc | docx | pdf | mht | htm | png | jpg | jpeg | bmp | 
txt | rtf. Leaving this list empty will allow 
NeuroWorks to use legacy product defaults; 
otherwise this list overrides those defaults. 

 

Note that dual-monitor placement should not be 
selected for reviewing studies migrated from DMS. 
The Coherence review application does not support 
startup on the second monitor. 

 

 

 

 

 

 

 

 

Figure 10: Addit ional Options Dialog 
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10. Features and limitations related to legacy studies 
in NeuroWorks 

Training users on features and limitations related to the implementation of legacy review applications is 
part of the installation process.  

10.1 Features: 

Reviewing the study Studies migrated from Legacy platforms are represented by the icons 
representing Nicolet NicOne, Grass TWin and Schwarzer Coherence: 

 

Like with native NeuroWorks studies, reviewing legacy studies can be 
accomplished either by double-clicking the study, or by selecting the study and 
clicking the “Review” button. This will launch the appropriate legacy viewer 
providing the same functionalities to the user as with the legacy platform. For 
example: any changes in the study, like changes to montages and annotations, 
will be stored in the data files providing that these are not read-only (archived 
on CD/DVD media). 

Displaying Study 
Reports 

For Legacy studies with the “Report” icon displayed in the “Reported” column, 
the user may right click the Study and select the option “Legacy Reports” 
to display the list of available reports. Select a report and click the “Open” 
button to display the report. 

 

Access to “Exports” 
(=pruned study data) 
after migration from 

Unlike with DMS, the NeuroWorks/SleepWorks database does not know is 
exported data exist. When reviewing a study migrated from DMS, the 
NeuroWorks/SleepWorks database will always open the original recorded 
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DMS study.  

If Exported study data exist, these can be opened from the “File” Menu in 
Coherence Review. From the exported data it is possible to return to the 
original study data in the same way.  

 

 

10.2 Limitations:  

 

The use of Legacy viewers in NeuroWorks should be limited to reviewing existing study data. 
New Study files generated by analysis features in the legacy viewer are NOT managed by 
NeuroWorks. 

 

Legacy EEG, VIDEO and REPORT study data shall remain on their location once migrated to 
NeuroWorks. As a result, legacy studies shall not be moved or archived from NeuroWorks. 

 

For Legacy studies, the “Technologist’s Report” tab in the Study Info window is not shown in 
NeuroWorks 8.1 GMA5. Consequently, information like “Handedness” is not visible. 

 

For Schwarzer DMS databases including studies migrated from Schwarzer Brainlab® or 
Harmonie® platforms, the user must be informed that the EEG and VIDEO study data cannot 
be reviewed from the NeuroWorks/SleepWorks database after migration.  

 

In case a patient migrated from the Legacy database is also present in the existing 
NeuroWorks/SleepWorks database a new patient record will be added. Patient records are 
never merged, resulting in duplicate records for those patients.    

 


